LENESANS Release Note

RZ/T2H Group

Encoder I/F EnDat sample program

Summary
This document describes the RZ/T2H Encoder I/F EnDat sample program package.

For EnDat 2.2 communication protocol specifications and encoder specifications (EQN1035), contact
HEIDENHAIN GmbH.

Functionality Checked Device
RZ/T2H Evaluation Board (RTKORZT2HXXXXXXXXX)
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RZ/T2H Group Encoder I/F EnDat sample program

1. Package Contents

This package contains the following contents.
The EnDat encoder interface of the RZ/T2H supports up to 16 axes, but the sample program uses only 1
axis of them. If you use with 2 axes or more simultaneously, modify the sample program to support required

axes.

1.1 Software
Source Code

No. Name Version
1 RZ/T2H EnDat sample program (CR52 ver. *) 2.0
2 RZ/T2H EnDat sample program (CA55 ver. *) 2.0

Note: This sample program has a CR52 version that runs on the CPU core Cortex-R52 and a CA55 version
that runs on the CPU core Cortex-A55. CR52 ver. and CA55 ver. are descriptions of the respective
version.

1.2 Documents

No. Document name Version File name
1 RZ/T2H Group Encoder I/F EnDat | 2.01 () r11an0796jj0201-rzt2h.pdf
sample program Release Note (e) r11an0796€j0201-rzt2h.pdf (this document)
2 RZ/T2H Group EnDat sample 2.00 (j) r11an0795jj0200-rzt2h-endat.pdf
program Application Note (e) r11an0795ej0200-rzt2h-endat.pdf
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RZ/T2H Group Encoder I/F EnDat sample program

2. File Structure

The file structure and contents of this package are detailed below.
Top
— r11an0796jj0201-rzt2h.pdf
— r11an0796ej0201-rzt2h.pdf
L— workspace
— Software
\ — iccarm
\ \ — RZ_T2H_CR52_endat.zip : RZ/T2H EnDat sample program set
o CR52 ver. (IAR)
| | L— RZ_T2H_CA55_endat.zip
| | F—RZ_T2H _CA55 0 _endat :RZ/T2H EnDat sample program set
| | CA55 ver. (IAR)
| | L—RZ_T2H_CR52_0_primary
| | : CPU_CTRL register setting program (IAR)
| —gcc
| — RZ_T2H_CR52_endat.zip : RZ/T2H EnDat sample program set
| | CR52 ver. (e2 studio)
| L— RZ_T2H_CA55_endat.zip
| —RZ_T2H_CA55 0_endat. :RZ/T2H EnDat sample program set
| \ CA55 ver. (e2 studio)
| L—RZ_T2H_CR52_0_primary
| : CPU_CTRL register setting program (e? studio)
L— Documents
— r11an0795j0200-rzt2h-endat.pdf
— r11an0795ej0200-rzt2h-endat.pdf

The file structure of the RZ_T2H_endat.zip and RZ_T2H_CA55_0_endat folder are shown below.

Top folder
— configuration.xml : FSP Configuration data
— ( Environment File Depending on Build Tool )
L—src
— hal_entry.c : EnDat sample program
— endat_main.c : EnDat sample program
— siochar.c : SCI_UART sample program
— siorw.c : SCI_UART sample program
— sio_char.h : SCI_UART sample program
L—drv
— endat
— iodefine_endat.h : EnDat register definition file
—r_endat_rzt2.c : EnDat driver file
—r_endat_rzt2_config.h : EnDat driver file
F—r_endat_rzt2_dat.h : EnDat driver file
L—r_endat_rzt2_if.h : EnDat driver file
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RZ/T2H Group Encoder I/F EnDat sample program

The file structure of the RZ_T2H_CR52_0_primary folder is shown below.

Top folder
— configuration.xml : FSP Configuration data
— ( Environment File Depending on Build Tool )
L—src
L— hal_entry.c : CA55 start-up program
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3. About EnDat Sample Program

This section contains information necessary to use the complete set of EnDat sample program.

3.1 Software Information
3.1.1 Base OS

This sample program is OS-independent.

3.1.2 Memory Size

Memory size used by this sample program and EnDat driver is shown in following table. This table does not
include memory size used by Flexible Software Package or C language libraries of the compiler.

(1) CR52 ver.

ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
EnDat driver Code 4.4 3.3
Data (with initial value) 0.0 0.0
Data (without initial value) 0.8 0.8
Constant Data 0.2 0.2
Sample program Code 2.8 3.2
Data (with initial value) 0.0 0.0
Data (without initial value) 0.4 0.4
Constant Data 1.2 1.2

(2) CADS55 ver.
ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
EnDat driver Code 6.5 5.3
Data (with initial value) 0.0 0.0
Data (without initial value) 1.0 1.0
Constant Data 0.3 0.3
Sample program Code 4.5 5.6
Data (with initial value) 0.0 0.0
Data (without initial value) 0.4 0.5
Constant Data 1.3 14
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Encoder I/F EnDat sample program

3.2 Hardware Information
3.2.1 Device
RZ/T2H

3.2.2 Target Board
(1) Board Name

RZ/T2H Evaluation Board (RTKORZT2HXXXXXXXXX)

(2) Setting of the Target Board
The target board configuration is as follows.
SW1-4: ON
SW1-6: OFF
SW2-1: ON, SW2-2: OFF
SW2-7: OFF
SW2-8: OFF

SW14-1: ON, SW14-2: OFF, SW14-3: ON, SW14-6: OFF (Set xSPI1 boot mode)

CN39: Short between 2-3pin (Set VDD1833_2 to 3.3V)
CN40: Short between 2-3pin (Set VDD1833_3 to 3.3V)

CN78: Short between 1-2 pins, Open between 3-4 pins, and between 5-6 pins (Set VDD1833_6 to 3.3V)

Note: To use target board RTK9RZT2HOCW1000BJ with connecting RS-485 board, power on/off by
plugging and unplugging to the power-supply connector CN47 with keeping the slide switch SW16 on.

R11ANO796EJ0201 Rev.2.01
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Encoder I/F EnDat sample program

(3) Used Pins of the Target Board

The correspondence between the pin used as the encoder I/F and the pin header of the target board is as

follows.
Channel Pin Name Pin Input/ Voltage Description
Header Output Domain
ENDAT_CHO | ENCIFCKO (TCLKO) CN2 #3 Input VDD33 Clock output
ENCIFOEO (DEO) CN2 #5 Output VDD33 Data output enable
ENCIFDOO (DATA_DVO) CN2 #7 Input VDD33 Data output
ENCIFDIO (DATA_RCO) CN2 #9 Output VDD33 Data input
ENDAT_CH1 ENCIFCK1 (TCLK1) CN2 #2 Input VDD1833_3 | Clock output
ENCIFOE1 (DE1) CN2 #4 Output VDD1833 3 | Data output enable
ENCIFDO1 (DATA_DV1) CN2 #6 Input VDD1833_3 | Data output
ENCIFDI1 (DATA_RC1) CN2 #8 Output VDD1833_3 | Data input
ENDAT_CH2 | ENCIFCK2 (TCLK2) CN2 #11 Input VDD33 Clock output
ENCIFOE2 (DE2) CN2#13 | Output VDD33 Data output enable
ENCIFDO2 (DATA_DV2) CN2 #15 | Input VDD33 Data output
ENCIFDI2 (DATA_RC2) CN2 #17 | Output VDD33 Data input
ENDAT_CH3 | ENCIFCK3 (TCLK3) CN2 #12 | Input VDD33 Clock output
ENCIFOE3 (DE3) CN2#14 | Output VDD33 Data output enable
ENCIFDO3 (DATA_DV3) CN2 #16 | Input VDD33 Data output
ENCIFDI3 (DATA_RC3) CN2 #18 | Output VDD33 Data input
ENDAT_CH4 | ENCIFCK4 (TCLK4) CN2 #21 Input VDD33 Clock output
ENCIFOE4 (DE4) CN2 #23 | Output VDD33 Data output enable
ENCIFDO4 (DATA_DV4) CN2 #25 | Input VDD1833_5 | Data output
ENCIFDI4 (DATA_RC4) CN2 #27 | Output VDD1833_5 | Data input
ENDAT_CH5 | ENCIFCKS5 (TCLK5) CN2 #20 | Input VDD1833_6 | Clock output
ENCIFOES5 (DE5) CN2 #22 | Output VDD1833 6 | Data output enable
ENCIFDO5 (DATA_DV5) CN2 #24 | Input VDD1833_6 | Data output
ENCIFDI5 (DATA_RC5) CN2 #26 | Output VDD1833_6 | Data input
ENDAT_CH6 | ENCIFCK6 (TCLK®6) CN3 #3 Input VDD1833_3 | Clock output
ENCIFOES6 (DEBG) CN3 #5 Output VDD1833 3 | Data output enable
ENCIFDO6 (DATA_DV6) CN3 #7 Input VDD1833_3 | Data output
ENCIFDI6 (DATA_RC6) CN3 #9 Output VDD1833_3 | Data input
ENDAT_CH7 | ENCIFCKY7 (TCLK7) CN3 #2 Input VDD1833_3 | Clock output
ENCIFOEY (DE7) CN3 #4 Output VDD1833 3 | Data output enable
ENCIFDO7 (DATA_DV7) CN3 #6 Input VDD1833_3 | Data output
ENCIFDI7 (DATA_RC7) CN3 #8 Output VDD1833_3 | Data input
ENDAT_CH8 | ENCIFCKS8 (TCLKS) CN3 #11 Input VDD33 Clock output
ENCIFOES (DES8) CN3#13 | Output VDD33 Data output enable
ENCIFDO8 (DATA_DV8) CN3 #15 | Input VDD33 Data output
ENCIFDI8 (DATA_RCS8) CN3 #17 | Output VDD33 Data input
ENDAT_CH9 | ENCIFCK9 (TCLK9) CN3 #12 | Input VDD1833_2 | Clock output
ENCIFOES9 (DE9) CN3 #14 | Output VDD1833_2 | Data output enable
ENCIFDO9 (DATA_DV9) CN3 #16 | Input VDD1833_2 | Data output
ENCIFDI9 (DATA_RC9) CN3 #18 | Output VDD1833_2 | Data input
ENDAT_CH10 | ENCIFCK10 (TCLK10) CN3 #21 Input VDD1833_2 | Clock output
ENCIFOE10 (DE10) CN3 #23 | Output VDD1833_2 | Data output enable
ENCIFDO10 (DATA_DV10) [ CN3#25 | Input VDD1833_2 | Data output
ENCIFDI10 (DATA_RC10) | CN3 #27 | Output VDD1833_2 | Data input
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Channel Pin Name Pin Input/ Voltage Description
Header Output Domain
ENDAT_CH11 | ENCIFCK11 (TCLK11) CN3#20 | Input VDD1833_2 | Clock output
ENCIFOE11 (DE11) CN3 #22 | Output VDD1833_2 | Data output enable
ENCIFDO11 (DATA_DV11) | CN3#24 | Input VDD1833_2 | Data output
ENCIFDI11 (DATA_RC11) | CN3#26 | Output VDD1833_2 | Data input
ENDAT_CH12 | ENCIFCK12 (TCLK12) CN10#3 | Input VDD1833_6 | Clock output
ENCIFOE12 (DE12) CN10#5 | Output VDD1833_6 | Data output enable
ENCIFDO12 (DATA_DV12) | CN10#7 | Input VDD1833_6 | Data output
ENCIFDI12 (DATA_RC12) [ CN10#9 | Output VDD1833_6 | Data input
ENDAT_CH13 | ENCIFCK13 (TCLK13) CN10#2 | Input VDD1833_6 | Clock output
ENCIFOE13 (DE13) CN10 #4 | Output VDD1833_6 | Data output enable
ENCIFDO13 (DATA_DV13) [ CN10#6 | Input VDD1833_6 | Data output
ENCIFDI13 (DATA_RC13) | CN10#8 | Output VDD1833_6 | Data input
ENDAT_CH14 | ENCIFCK14 (TCLK14) CN10 #11 | Input VDD33 Clock output
ENCIFOE14 (DE14) CN10 #13 | Output VDD33 Data output enable
ENCIFDO14 (DATA_DV14) | CN10 #15 | Input VDD33 Data output
ENCIFDI14 (DATA_RC14) [ CN10 #17 | Output VDD33 Data input
ENDAT_CH15 | ENCIFCK15 (TCLK15) CN10 #12 | Input VDD33 Clock output
ENCIFOE15 (DE15) CN10 #14 | Output VDD33 Data output enable
ENCIFDO15 (DATA_DV15) [ CN10 #16 | Input VDD33 Data output
ENCIFDI15 (DATA_RC15) | CN10 #18 | Output VDD33 Data input
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Encoder I/F EnDat sample program

3.3 Procedures on Development Environments: CR52 ver.

3.3.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN34.
Select higher-numbered port from COM ports that appear at connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Sending / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.3.2 EWARM from IAR Systems
(1) Build Environment

IAR Embedded Workbench for ARM (EWARM)

Version 9.60.2 + patch (EWARM_Patch_for RZT2H N2H_rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2024-10
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs
The build procedure for the sample program is as follows.

1 Extract RZ_T2H_CR52_endat.zip and copy the extracted source files to the desired location.
Activate EWARM.

2
3 Select [File] menu -> [Open Workspace].

4 Open the extracted source file RZ_T2H_endat.eww.

5 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS$
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.
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In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

!a C:¥1_Prog¥Work¥Work_C¥Work_EWA_960_2_fsp2.2.0¥RZT2H_EnDat_release_chk - FSP Smart Configurator

- O X
File Window Run Help
45% [RZT2H_EnDat_release_chk] FSP Configuration X iien °% PSP Visualization =8
0 :
+ >

Summary Generate Project Content n

Project Summary A

RENESAS

Board: RZT2H Evaluation Board (RAM execution without flash memory)

Device: RYA09G077M44GBG

Core: CR52 CPUO

FSP Version: 22.0
Project Type: Flat

Location: C:/1_Prog/Work/Work_C/Work_EWA_960_2_fsp2.2.0/RZT2H_EnDat_release_chk |

Selected software components

Board support package for ROA09G077M44GBG

v2.2.0
Board support package for RZT2H v2.2.0
Board support package for RZT2H - FSP Data v2.2.0 X

Q=0

Summary | BSP| Clocks| Pins | Interrupts | Event Links| Stacks | Components

=] Properties [2ll Problems )

o00

= 0 B console

No consoles to display at this time.

M=

Properties are not available.

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\RZ_T2H_endat.out is generated.

(4) Sample Program Execution Procedure

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].
(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/T2H Group EnDat Sample Program Application Note.

¥ COM14 - Tera Term VT

JrF) \EE FES IvEO-IW0)  91uEIW) ALTH)
] rt
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3.3.3 e? studio from RENESAS
(1) Build Environment

RENESAS e? studio 2024-10
Toolchain version: GNU ARM Embedded 12.2.1.arm-12-24
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0
(2) Execution Environment ICE
SEGGER J-Link v7.98c
(3) Build Procedure of the Sample Program

The procedure for building the sample program is as follows.

1 Extract RZ_T2H CR52_endat.zip and copy the extracted source files to the desired location..
2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select

Existing project to workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root

directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].
5 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

& EnDat_release_chk - e? studio
File Edit Source Refactor Navigate Search Project Renesas Views Run Window Help
|®~-4~ o ide Qv
&5 Project Beplorer X | = B8
ES
v % RZ_T2H_endat [Debug]

[nl! Includes

pel

=| RZ_T2H_endat Debug_Flat jlink

K| RZ_T2H_endat Debug_Flat.launch

(@) Developer Assistance

121 Problems X | B Console | [Z] Properties @ Smart Browser | L) Smart Manual

0 errors, 12 warnings, 0 others

Description Resource

Y Warnings (12 items)

< > <

e configuration.xm| - RZ_T2H_endat

- m} X

Q | Ecc
0= Outline X =8 5

@)
There is no active editor ()]
that provides an outline.

Path Location Type
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Page 11 of 19
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6 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rzt, rzt_cfg, rzt_gen, script and .settings folders are generated.

@ EnDst_release_chk - RZ_T2H_endat/configuration.xml - € studic - O X
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help
R 0ty v Qv Q B Eccs
1 Project Explorer =0 RZ_T2H_endat] FSP Configuration = Qutline =0
= Summary o There is o active editor that provides
v = RZ_T2H_endat Generate Project Content an outline.
a3l Includes i
e Project Summary al
RENESAS
configuration.xml
Board: RZT2H Evaluation Board (RAM execution without flash memory)
RZ_T2H_endat Debug _Flatjiin}
Device: ROADIGO77MA4GBG
X RZ_T2H_endat Debug_Flatlaui N
2 . Core: CRS2 CPUD
Dewveloper Assistance
Toolchain: GCC for Renesas RZ
Toolchain Version: 12.2.1.arm-12-24
FSP Version: 220
Project Type: Flat
Location: C11_Prog/Work/Work_G/Work_E2S_RZ....0/EnDat_release_chk/RZ_T2H_endat <=
Selected software components
Board support package for RIAD9GOT7TMA4GBG v2.2.0
Board support package for RZT2H v22.0
Board support package for RZT2H - FSP Data V220 %
St BSP Clocks Pins | Interrupts Event Links Stacks Components
+! Problems B console [ Properties @ Smart Browser | 5 Smart Manuaf =08
0 errors, 12 warnings, 0 others
Description Resource Path Location Type
% Warnings (12 items)
< >

7 Select [Project] menu -> [Build All]
The Debug\RZ_T2H_endat.elf file is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].
2 Click [Debug] to start downloading to internal RAM.
3 Click [Run] menu -> [Resume] to run the sample program.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/T2H Group EnDat Sample Program Application Note.

T COMA14 - Tera Term VT — O *
JrAILF) REE EBE(S) VOO S4vEIW) ALTH)
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3.4 Procedures on Development Environments: CA55 ver.

3.4.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN34.
Select lower-numbered port from COM ports that appear at connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Sending / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.4.2 EWARM from IAR Systems

(1) Build Environment

IAR Embedded Workbench for ARM (EWARM)

Version 9.60.2 + patch (EWARM_Patch_for RZT2H N2H_rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2024-10
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs

The build procedure for the sample program is as follows.

1 Extract RZ_T2H_CA55_endat.zip and copy the extracted source files to the desired location.

Activate EWARM.

a b wN

Select [File] menu -> [Open Workspace].
Open the extracted source file RZ_ T2H _CR52_0 _primary -> RZ_T2H_CR52_0_primary.eww.
Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS$
Argument --compiler IAR configuration.xml

Initial directory

$PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.
You can also start the FSP Smart Configurator directly from the command prompt by specifying the

folder where it is installed.

R11ANO796EJ0201 Rev.2.01
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6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

[EG C:¥1_Prog¥Work¥Work_C¥Work EWA 960_2_fsp2.2.0RZT2H_EnDat_CAS5_release_chk¥RZ_T2H_CR52_0_primary - FSP Smart Configurator
File Window Run Help

## [RZ_T2H_CR52_0_primary] FSP Configuration X il %

"D FSP Visualization =8

Summary

Board:
Device:
Core:

FSP Version:
Project Type:
Location:

Generate Project Content

L=l /

Project Summary

RENESAS
RZT2H Evaluation Board (RAM execution without flash memory)
RY9A09G077M44GBG
CR52 CPUO
220
Flat
C:/1_Prog/Work/Work_C/Work_EWA_96...release_chk/RZ_T2H_CR52_0_primary |

A

Selected software components

Board support package for ROA09G077M44GBG v2.2.0
Board support package for RZT2H v2.2.0
Board support package for RZT2H - FSP Data v2.2.0 N/

QEO

Summary | BSP| Clocks| Pins | Interrupts | Event Links | Stacks | Components > AB

[ Properties [2] Problems % § =8 B console

No consoles to display at this time.

Properties are not available.

> H =5

»

7 When project generation is complete, close the Smart Configurator.

8 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\RZ_T2H_CR52_0_primary.sbd is generated.
9 Select [File] menu -> [Open Workspace].

10 Open the extracted source file RZ_T2H_CA55_0_endat —» RZ_T2H_CA55_0_endat.eww.
(RZ_T2H_CR52_0_primary.sbd of the primary project is referenced to open this workspace file.

Please build the primary project in advance.)

11 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE.
12 In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,

rzt_cfg, rzt_gen, script and .setting folders will be generated.

[EG C:¢1_Prog¥Work¥Work_C¥Work_EWA 960_2 fsp2.2.04RZT2H_EnDat_CA55 release chk¥RZ_T2H_CAS5_0_endat - FSP Smart Configurator
File Window Run Help

4 [RZ_T2H_CAS5_0_endat] FSP Configuration X

= = 4

FSP Visualization =8

Summary

Generate Project Content

Project Summary

Board:
Device:
Core:

FSP Version:
Project Type:

RENESAS
RZT2H Evaluation Board (RAM execution without flash memory)
RO9A09G077M44GBG
CA55 Core0
220
Flat

A

Location: C:/1_Prog/Work/Work_C/Work_EWA_96...5_release_chk/RZ_T2H_CA55_0_endat =/

Selected software components

Board support package for ROA09G077M44GBG v2.2.0
Board support package for RZT2H v2.2.0
Board support package for RZT2H - FSP Data v2.2.0 M

Q=0

Summary | BSP| Clocks| Pins| Interrupts | Event Links | Stacks | Components > ALBI

[ Properties [21 Problems %8 =8 Bconsole

No consoles to display at this time.

Properties are not available.

~vB-=8

13 When project generation is complete, close the Smart Configurator.

14 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\ RZ_T2H_CA55 0_endat.out is generated.

R11ANO796EJ0201 Rev.2.01
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RZ/T2H Group Encoder I/F EnDat sample program

(4) Sample Program Execution Procedure

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Inthe workspace of RZ_T2H_CR52_0_primary, select [Project] menu -> [Download and Debug].
RZ_T2H_CA55 0_endat project is launched.

2 Inthe workspace of RZ_T2H_CR52_0_primary, select [Debug] menu -> [Execute]. CA55 start-up
program is executed.

3 Inthe workspace of RZ_T2H_CA55 0_endat, select [Debug] menu -> [Execute]. Sample program is
executed.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/T2H Group EnDat Sample Program Application Note.

¥ COM14 - Tera Term VT - O *
IrAWF) |EE BES IVEO-IHO) DUFEIW) ALTH)
at s

3.4.3 e? studio from RENESAS
(1) Build Environment

RENESAS e? studio 2024-10
Toolchain version:
GNU ARM Embedded 12.2.1.arm-12-24 (Used by RZ_T2H_CR52_0_primary.)
GCC ARM A-Profile (AArch64 bare-metal) 10.3.1.20210621 (Used by RZ_T2H_CA55_0_endat.)
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
SEGGER J-Link v7.98c

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Extract RZ_T2H_CA55_ endat.zip and copy the expanded source file to any location.

2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select
Existing project to workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root
directory.
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RZ/T2H Group

Encoder I/F EnDat sample program

4 Select a project, check Copy Project to Workspace, and click [Finish].
5 Double-click the configuration.xml of the RZ_T2H_CR52_0_primary project in the Project Explorer

pane of e? studio to open it.

a EnDat_CA55_release_chk - e? studio

|® -4~ wite Q-
[ Project Explorer =g
=55 Y §
v 5 RZ T2H_CA55_0_endat
) Includes
LQSFC

5 configuration.xml
= RZ_T2H_CA55_0_endat Debug_F
|X] RZ_T2H_CA55_0_endat Debug_F
(2) Developer Assistance
v |5 RZ_T2H_CR52_0_primary [Debug]

[ Includes
co

f’i> configuration.xml

TeRE2-0 primary Debug

[X] RZ_T2H_CR52_0_primary Debug
(@) Developer Assistance

Description
% Warnings (24 items)

< >

i) configuration.xml - RZ_T2H_CR52_0_primary

File Edit Source Refactor Navigate Search Project Renesas Views Run Window Help

121 Problems X | & Console | [=] Properties| @ Smart Browser 5 Smart Manual

0 errors, 24 warnings, 0 others

- O x

Q B|@cc
= O || gz Outline X =R
There is no active editor that €%

provides an outline.

= 0

=

000

Resource Path Location Type

6 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rzt, rzt_cfg, rzt_gen, script and .settings folders are generated in the RZ_T2H_CR52_0_primary

project.

@ EnDat_CASS release_chk - RZ_T2H_CRS2_0_primary/configuration.xml - e studio
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help

o ity Q-

() Project Explorer D § =0
65 RZ_T2H_CA55_0_endat
il enda Summary
i) Includes

B sic

o [RZ_T2H_CR52_0_primary] FSP Configuration

- a * ‘

Q E|fEoce

iy G Outline X =0|s

There is no active editor that provides an (€8
Generate Project Content | o, tiine

< >

18 configurationxml - RZ_T2H_CRS2_0_primary

O=EO

Summary | BSP| Clocks| Pins  Interrupts | Event Links | Stacks Components

71 Problems | B Console | ] Properties| @ Smart Browser| 1 Smart Manual
0 errors, 24 wamings, 0 others
Description Resource. Path

i Wamnings (24 items)

Location

Type

£ configuration.xml Project Summary 2ENE [~)
RZ_T2H_CA55_0_endat Debug _Flat jlink
%) RZ_T2H_CAS5_0_endat Debug_Flatlaunch g“"’:_ gli:;"f;‘;:jfgs;“'d (RAM execution without flash memory)
7 Developer Assistance C:‘:‘;" R oPLD
v 5 RZ T2H i [Dek -
= u}nz‘ (’JCRSZ'O"’ rman Toolchain: GG for Renesas RZ
o Toolchain Version: 12.2.1.arm-12-24
— . FSP Version: 220
4 configuration.xml Project Type: ot
RZT2H CR32.0 primary Debug Flatfink 1y o aion: C:/1_Prog/orkWork_C/Work_E2S_RZ..release_chk/RZ_T2H_CR52_0_primary <4
%) RZ_T2H_CRS2.0_primary Debug_Flatlaundl
D Developer Assistance Selected software components
Board support package for RIADSGOT7MA4GBG 220
Board support package for RZT2H 220
Board support package for RZT2H - FSP Data v2.2.0 o

7 Select RZ_T2H_CR52_primary project in the Project Explorer pane and execute [Run] menu -> [Build

Project].

The file Debug\RZ_T2H_CR52_0_primary.sbd is generated.
8 Double-click the configuration.xml of the RZ_T2H_CA55_0_endat project in the Project Explorer pane
of e? studio to open it. (RZ_T2H_CR52_0_primary.sbd of the primary project is referenced to open this
configuration file. Please build the primary project in advance.)

R11ANO796EJ0201 Rev.2.01
Dec 13.24

RENESAS

Page 16 of 19



RZ/T2H Group Encoder I/F EnDat sample program

9 Click Generate Project Content in the FSP Configuration pane of e2 studio.
The rzt, rzt_cfg, rzt_gen, script, .settings folders are generated in the RZ_T2H_CA55 0_endat project.

8 EnDat_CASS release_chk - RZ_T2H_CASS5_0_endat/cenfiguration.xmi - e studio

- a x ‘

File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help

BrR~ o it Qv Q B[ e
(3 Project Explorer X = § = O | & Rz_T2H_CRS2 0 primary] FSP Configuration 2 [RZ_T2H_CAS5_0_endat] FSP C: = Qutline X S 0Ols
-

w [55 RZ_T2H_CA55_0_endat (v] There is no active editor that provides an €%

5 Includes ALy Generate Project Content | oyine.

B

8 configurationxm! Project Summary 2

B RZ_T2H_CA55_0_endat Debug _Flat jlink RENE

T2H_CA55_0_endat Debug,Flatjlin

B) RZ T2H.CASS. 0, andit Debug._Flatlounch guard:- gli:civva;ﬁfgsgmd (RAM execution without flash memory)

) Developer Assistance CZ:I:E‘ CAS55 Core0
|5 RZ_T2H_CR52_0_prir N

'jt,;e HCRE S prmany Toolchain: GCC for Renesas RZ (A-Profile AArch64 bare-metal)
inaries N !
Inchud Toolchain Version: 10.3.1.20210621

i Inch

 Indudes FSP Version: 220

e Project Type: Flat

£ e Location: C:1_Prog/Work/Work_C/Work_E2S_RZ..5_release_chk/RZ_T2H_CA55_0_endat <=

e

& Debug Selected software components

&zt cfg

& script Board support package for RIAOSGOT7MA4GBG V220

1 configuration.xml| Board support package for RZT2H V220

RZ_T2H_CR52.0_primary Debug_Flatjink Board support package for RZT2H - FSP Dala v2.20 M

% RZ_T2H_CR52.0_primary Debug_Flatlaunc] =
%) Developer Assistance @ ¥
Support li} ==

Summary | BSP| Clocks| Pins | Interrupts| Event Links | Stacks Components

¥ Problems | & Console < | =] Properties| @ Smart Browser & Smart Manual ®
CDT Build Console [RZ_T2H_CASS_0_endat]

585 - R@#B-5- -0

10 Select [Project] menu -> [Build All].
Files Debug\RZ_T2H_CA55 0 _endat.elf is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging] for the
RZ _T2H _CR52_0_primary project.
Click [Debug] to start downloading to internal RAM.

2 Click [Run] menu -> [Resume] to run the CA55 start-up program.

3 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging] for the
RZ _T2H_CA55 0_endat project.

4  Select 'No' when the dialog box inquiring about termination of the active debug session is displayed.
& Launcher x

l A Renesas GDB debug session is already active.

Do you want to terminate all currently active debug sessions before starting the new
session? (Note: Selecting No may result in unstable debug functionality)

[] Remember my decision

es | Mo Cancel

5 If 'Proceed with launch' is displayed, select 'Yes'.
6 Click [Debug] to start downloading to internal RAM.
7 Click [Run] menu -> [Resume] to run the sample program.
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RZ/T2H Group Encoder I/F EnDat sample program

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/T2H Group EnDat Sample Program Application Note.

T COM14 - Tera Term VT - O *
JVRO-JW0)  24VEIW) ALTH)
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RZ/T2H Group Encoder I/F EnDat sample program

Revision History

Description
Rev. Date Page Summary
0.50 0Oct.06.23 First Edition issued.
0.60 Apr 26.24 2-4 Update the application note and release note version number.

Update sample program version to 0.6 (Support FSP v1.3.0.
Correct to report watchdog error.)
Update file structure. Add structure of CA55 version.

5 Update memory size information. Add information of CA55 ver.

1,6 Update description of the board name.
9-12 Update build environment and figures for CR52 ver.
13-17 Add development procedures for CA55 ver.
2.00 Nov.21.24 2-4 Update revisions of the application note and the release note.
Update sample program version to 2.0. (Supported FSP
v2.2.0.)
Update the file structure.

5 Update memory size information.

6 Add xSPI11 boot mode in setting of the target board.
9-18 Update build environment for FSP v2.2.0. Figures are
replaced.
2.01 Dec 13.24 2,3 Update revision of the release note.
Correct path name of the FSP SC in the sample program
environment files to use default installation path.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LS| are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. Nolicense, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for

each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.

Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products

outside of such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2024 Renesas Electronics Corporation. All rights reserved.
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